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What's New in Web Weaver!

Here's what's coming in Web Weaver!!

  Frame templates which provide you with preformatted Web pages with Netscape 
Frames layouts.    Different templates provide upper and lower banners, side bar 
frames for menus, etc.

  An online help reference providing beginner, intermediate, and advanced classes 
in HTML and other Web-related topics.

  More templates for Internet and Intranet uses including 1997 calendar and 
employee profile templates.

  An improved and more intuitive dialog box for Table cells.

  An option to save your HTML files in UNIX format.

  New toolbox including all HTML tags.

What's New in version 5.2e
  A new main menu screen asking whether the user wishes to use Web Weaver, 

Web Wizard, 
the Web Weaver HTML tutorial, or view the List of HTML tags in the Web Weaver 
help file.

  Advanced features were added to the Inline Image dialog box.    These include 
imagemap 
declarations and AVI video properties for inserting video clips.

  Print menu item is now functional.    Choosing Print will open the specified 
application 
(e.g., Notepad, Write, etc.) in order to print the HTML document from that opened 
application.

  A "fixed directory" item has been added to the Inline Image box and the Page 
Properties box
to provide a quick way to insert the full path and filename of the image being 
chosen.    This way
the links to the images will always work regardless of the location of the HTML file 
which has
links to them.



  A DTD DOCTYPE tag has been added to the default startup "new" document to 
alert browsers that
the document is an HTML 3.2 document and that it should be interpreted as such.

  META tags have been added to the "Advanced" section of the Page Properties 
dialog box.    These 
allow the HTML document to specify it's description and keywords, and to make the 
HTML document
have the ability to refresh itself or jump to another page after a specified time has 
expired.

  A Frames wizard called Frame Maker has been added.    Since recent versions of 
Web Weaver 5.2
the NOFRAMES tag has been added to the output of the Frame Maker.

  When the Preferences dialog box is opened, all existing preferences are displayed 
in the
appropriate text boxes.

  The "working directory" (set in the Preferences box) now works properly when set. 
When 
opening or saving HTML documents the "working directory" is shown by default to 
provide 
quick and easy access to the directory which you specified as your "working 
directory".    If
you access another directory (save to another or open from another) this causes the
working 
directory to change to the current directory for the next time you are saving or 
opening.

  The Math menu items and the Attributes menu items have been removed.    
McWeb software feels 
that these were too specific as well as unnecessary menu items.    Also, all of the 
attribute menu 
items for forms and tables were removed as well.

  New keyboard shortcuts have been added to Web Weaver.    These include
CTRL-T <TABLE></TABLE>
CTRL-R <TR></TR>
CTRL-D <TD></TD>

  The Backgroud/BGcolor menu item has been renamed to Page Properties because 
it controls more
than just the colors of the Web page.

  The HTML Stripper has been improved to handle carriage returns, Headers <H1>, 
<CENTER> tags
and more to provide you with a more accurate strip.



  The Font format dialog box has been enhanced to graphically display the effects 
of the
different font formats (e.g., the bold item is actually bolded to demonstrate the 
effect
that selection would have on selected text).

  The PNG image format has been added to the image selection dialog boxes.    This 
format is 
supported in the HTML 3.2 specification.

  List dialog boxes (bulleted, numbered, etc.) have been revised to provide a more 
intuitive
way to create lists.    One button was removed and the others were programmed to 
give the list
dialog boxes a more step by step approach.

What's New in version 5.1

  New start-up screens that ask the user whether they wish to start a new 
document or open an existing one.    If 'New document' is chosen then the dialog 
box for setting background colors and properties opens for user input.    If 'Existing 
document' is selected, an 'Open File' dialog box appears for the user to select the 
file they wish to open.    The user can also set Web Weaver so these start-up dialog 
boxes do not appear.

  New comprehensive toolbox which includes all the common HTML tags so they are
at your fingertips.    Also, there should be no more problems with the toolbox 
disappearing behind the Web Weaver window or covering menu items.

  When you open the Options/Preferences dialog box the existing settings are 
shown.    Also, when you change a preference and click "OK" to accept the settings 
they are automatically updated without having to restart Web Weaver.    Also, if Web 
Weaver encounters a problem it will ask you if you wish to investigate your settings.

  Internet Explorer tags and Java tags are included in dialog boxes for Marquee, 
Fonts, Background sound, Applets and applet parameters.    More IE and Netscape 
tags are supported in the Inline Image dialog box including Runtime video insertion, 
client side image maps, and an input box for the directory where the inline image 
will reside is now included.

  When entering Background colors/properties the cursor can now be located 
anywhere in the 
current document, and the codes will be correctly placed inside the <BODY> tag.

  The inline graphics dialog box now has a much improved Align tag preview along 
with an explanation of what each Align attribute does.    Also, the inline image



dialog box has a more organized look.

  Tooltips for each button on the button bars explain what each button does.

  The Find/Replace function has been improved.

  Larger buttons are used on the button bar for ease of use.

  Tooltips are now available in Web Weaver 5.1.

    A dialog box for the creation of HTML code for client side image maps is now 
available.

  Your favorite and most commonly used URLs can be placed in the INI file and Web 
Weaver will allow you to access them easily with pull-down boxes in the Hypertext 
and Inline Image dialog boxes.

  The location and size of the Web Weaver main window is memorized on exit so 
when you start Web Weaver up the next time it will be as you left it.

  A Close All menu item has been added to the Window menu.    This allows the user
to easily close all the open documents at the click of a button.    If the user has 
made changes to any of the documents, Web Weaver notifies the user for each 
modified document and asks if the user wishes to save the changes.

  Clicking on the current time display at the bottom of the Web Weaver main 
window will result in the time and date being inserted into your document.

What's New in version 5.0a!

  Improved menu layout - Most code is in alphabetical order for easier finding.

  The HTML 3.0 menu item has been removed because it would have made it more 
confusing to find the HTML tag that you wanted.    All HTML 3.0 tags are included in 
the Insert menu item.

  HTML tags have been separated into their correct categorical menu headings such
as: Physical Style Tags; Logical Style Tags, Paragraph/Text Elements, etc.

  MUCH MUCH MUCH! more HTML code, both HTML 2.0 and 3.0, including Math 
tags, Attributes, more special characters, etc. have been added to Web Weaver.    
Over 100 menu items in all.

  Now when you open a document, Web Weaver maximizes it to cover the whole 
Web Weaver screen.

  Most dialog boxes now have Help! buttons on them for context sensitive help on 



that particular item.

  Dialog boxes also have a sleek new look.    No more bold text headings, smaller 
buttons, leaner, etc.

  Special characters now have input dialog boxes for easier insertion, and include 
math variables, vowels, and various characters.

  Includes image mapping software Map THIS! and provides a menu item to link to 
that software.

  Link to FTP Client option on the menu bar.

    Improved HTML Form entry dialog box(FORM MAKER) providing a preview of each 
type of form input.

  HTML 3.0 Tables are now supported.    TABLE MAKER makes it very easy to insert 
tables into your HTML document.

  Background and BGColor settings dialog box are now combined and now include 
tags for
visited link and active link colors.    Also, the text labels(Linked text, Visited text, 
etc.) for each type of Web text change to the color that you have chosen.    Color 
boxes adjacent to the labels also display the color you have selected for the 
respective Web page text color.

  Options and preferences settings dialog box that will update the INI file 
automatically.
Settings include: Working directory, Image directory, Working Font, Fontsize, 
Browser path/name, FTP client path/name, and ImageMapper path/name.

  Toolbox settings dialog box that automatically updates the INI file.

  Web Weaver opens with a default template which includes the necessary tags to 
create a 
"grammatically correct" HTML document

  Allows the user to open a user-defined template to start a document.    When 
choosing Open from the pull-down menu, the template file type (.wwt) has been 
added to the list to choose from.

  Date & Time menu item, inserts the current date and time into the document.    
Also, each new document is time/date stamped with a comment at the top of the 
document.

    ISMAP tag, FIGure tag, and Alignment preview box are added to the Inline Image 
dialog box

  An insert button is added to the Inline Image box so the user can insert inline 



image attributes into the document without having to create an entire Inline Image 
tag (e.g., Align=Top)

  Align options in Inline Image box are in a list box format to minimize the size of 
the dialogbox.

  Attribute menu item added to the Insert menu allowing the user to insert common
HTML attributes.

  Built in Tutorial for beginners.

  Web Wizard provides an easy way to create a simple HTML document

  User can now specify the name of the stripped file when stripping HTML tags from
a document

  The Web Weaver icon has a transparent background.

    More buttons on the screen for easier access to FTP client, browser, etc.

  The HTML Stripper has had a few bugs fixed in it.    It used to skip some 
characters, but now it parses all characters.

  More sample images and backgrounds are included for your use.

What's new in version 5.0!
  Multiple Document editing is supported in this version.

  A recent file list of 4 files is listed at the bottom of the File menu item similar to 
most commercial word processor's recent files list.

  User defined toolbox is included, allowing 5 user defined buttons to be assigned.

  Right click pull-down menu is available which is similar to most word processors 
including Cut, Copy, Paste, limited Undo, etc.

  Find/Replace capabilities.

  More HTML and Netscape TAG including MailTo, Background Colors, and 
Background Wallpaper.

    Fonts dialog box is supported for using any system fonts in your text window.



    TAGs for Forms are included in the Form dialog box under the Insert/Form menu 
item.

  Interactive Menu Lists and Directory Lists are added to the Insert Lists menu item.

    Eventually HTML 3.0 Tables will be supported and also an Options box which will 
allow the user to change browsers to link to, working fonts, working directories, etc. 
by automatically changing the INI file.



Web Weaver Tutorial

HTML (HyperText Markup Language) is the programming language used to create Web pages.   
It is more of a publishing language than a programming language, nonetheless it is a fairly 
simple language to learn.    The basic elements of an HTML document are text and graphic 
images.    The text can be normal text(static), or it can be hypertext(dynamic) which allows a 
user to click on that particular text and be whisked away to another Web page, sound, picture, 
or animation.    Graphic images called 'Inline Images' are pictures that are seen on a Web page. 
These, too, can be 'linked' to another Web page, sound, picture, or animation.    Combining text, 
hypertext, inline images, and linked images, you can create your own Web page in minutes!    
See?    It's as simple as that!!! 

The millions of existing Web pages are all linked together by one thing, the World Wide Web.    
The Web allows users to access Web pages from all over the world to access any information 
that is possibly available.    Enough about the Web, though.    You must already know everything 
about it, otherwise you wouldn't be reading this.    The basis behind HTML is the use of tags 
(code) which surround text and describe to the Web browser how the text and images should 
appear to the user.    First we will discuss the format of an HTML tag and see how it is used.

The Format of an    HTML Tag
HTML tags consist of less than and greater than signs ( < and >) surrounding the main HTML 
code.    For example, <HTML CODE>.    The code can be uppercase, lowercase or both.    It is 
not case sensitive, however I like to put all code in capital letters to make it easier to see when 
editing HTML documents.

Many tags have opening tags and closing tags so that the Web browser understands where to 
begin and where to end a certain property, such as font, text type, font size, color.    For 
example, the HTML tag which makes text appear bold to the user is simply the letter B enclosed
in the HTML brackets, <>.    If the author of the HTML document put the opening bold tag and 
didn't put an closing bold tag, how would the browser know when to stop making the text bold?? 
For example, if you wanted to make the word 'bird' appear bold on the browser's screen you 
would type the code:

<B> bird </B>

Note that the closing tag has a slash inside the brackets, and before the HTML code, B.    This 
slash denotes an closing tag, and tells the browser that any text after the bold closing tag </B> 
will NOT be bolded.    So if we were to include the word 'bird' in a sentence and only wanted 
'bird' to be bolded, then we would type this:

One of my favorite animals is the <B>bird</B> because it can fly.

This is how it will appear:

One of my favorite animals is the bird because it can fly.



If you wanted the entire sentence to be bolded, then the HTML bold tags would surround the 
entire sentence as shown below:

<B>One of my favorite animals is the bird because it can fly.</B>
One of my favorite animals is the bird because it can fly.

Note that not all HTML tags have closing tags.

Where do I start?
Beginning an HTML document is not a difficult thing.    Once you get the hang of it, you'll be 
writing ten Web pages a day.    It is important to have good form when you are writing Web 
pages for several reasons.    One is so you can understand what you wrote in your document 
when you try to edit it a while after you first wrote it.    Another reason to have good form is to 
ensure that the Web browser will understand what you wrote and display the Web page as you 
intended.

1. Let's begin at the beginning.    Some HTML tags are not required for your Web page to 
work properly, but it is good practice to include them in your document.    Web Weaver starts 
new documents with these tags so you don't have to worry about putting them in.
The first and foremost tag is the <HTML></HTML> tag.    This opening and closing tag surround 
the entire HTML document, and they tell the Web browser that 'this document is an HTML 
document'.    This tells the browser that it is to be read as a Web page.    All other text and tags 
are surrounded by the <HTML></HTML> tags.    Anything outside of the <HTML></HTML> tags 
are usually ignored by the browser.    

2. Next is the <HEAD></HEAD> tag.    This encloses the head of the HTML document.    
The head of the document contains information about the HTML document, but that information 
is never seen by the user on the other end reading the Web page.    This information is used by 
the browser to index or keep track of the document.    One of the main HTML tags that goes 
inside the <HEAD></HEAD> tag is the <TITLE></TITLE> tag.    This tells the browser the title of
the Web page so it can refer to the page as 'something'.    The title is usually seen on the 
browser's titlebar when it has accessed the page.    It is also the title that is used as the 
bookmark when you save a bookmark to your favorite Web pages in your browser.

3. The next important tag which follows the <HEAD></HEAD> tag is the <BODY></BODY>
tag.    This tag encloses the body of the document (all the text and HTML tags).    The bulk of 
your HTML code and text is located between the <BODY></BODY> tags.    Whatever is 
contained within the <BODY></BODY> tags is interpreted by the browser and is shown on-
screen as part of the Web page.    Any text or tags outside of the body tags are meant to be 
interpreted by a browser in order to gain information about your Web document.

Here is the order in which these main HTML tags should be placed:

<HTML>

<HEAD>



<TITLE> This is the Title of the Web Page </TITLE>
</HEAD>

<BODY>
All the text of the document
</BODY>

</HTML>

See Web Wizard for additional explanation of these tags.

Text
Usually, the main element of a Web page is the text.    The text allows users to gain information 
about whatever the Web page discusses.    We all know that typing text is easy, but formatting it 
and laying it out is the difficult task.    Well, you could just have all of your text be the same size, 
same font, same look, same feel, same boring words typed over and over OR you could use 
some of the HTML physical style and paragraph tags to really spruce things up.    A Web page 
with a boring layout will attract no one, but a nicely formatted page will keep them coming back 
for more.    
First, we will talk about text size.    The HTML 2.0 specification calls out different heading sizes 
which are used to change on-screen text size.    These headings have basic opening and 
closing tags in the form    <H1></H1> to <H6></H6> (H1 being the largest font size).    For 
example, if you wanted the on-screen title of your page to be 'Dogs and Cats: Can They Be 
Friends?', you may want to have this text be larger than the normal text so it stands out as the 
title of the page.    To do this type:

<H1>Dogs and Cats: Can They Be Friends?</H1>

This will appear like:

Dogs and Cats: Can They Be Friends?
These headings are useful, but unfortunately they can really only be used on one line at a time.  
In other words, if I wanted 'Dogs' to be one size and 'Cats' to be another, I couldn't use HTML 
2.0 heading tags.    As soon as I specified a heading for a word/phrase, the next word following 
the heading closing tag </H1> would be placed on the next line.    Any text size change would 
result in one text size per line.    Another option would be to use Netscape extensions to HTML.   
These additional HTML tags are understood by mostly Netscape browsers and only a selected 
few other browsers.    This is one drawback to using them.    If you format your Web page to look 
good on Netscape by using Netscape extensions, it may look terrible on another browser.    
Regardless, the extension <FONT SIZE=#></FONT>, where # is a number from 1 to 7 (1 being 
small size, 7 being large), can be used to change the text size of each letter in a word, if 
desired.    For example, if you wanted the word 'bird' to have a large 'b' and a somewhat smaller 
'd', you could type:

<FONT SIZE=7>b</FONT>ir<FONT SIZE=5>d</FONT>



would appear like:

bird
You may wish the appearance of the text to be different, also.    There are bold (as discussed in 
the beginning of this tutorial) and italic tags so you can highlight or appropriately format your text
as you need to.    These tags are simple tags and follow the same format as the tags discussed 
above.    They have opening and closing tags and surround the text that they enhance.    For 
example, to make a word bold, simply follow this syntax:

<B>word</B>
and it will appear like:    word
To include it in a sentence, follow this example:

This <B>word</B> will appear bold in this sentence.

and you will see:

This word will appear bold in this sentence.

Other physical style tags are available in the Insert_Physical Style Tags menu in Web Weaver.

Logical style tags are used to describe text and tell the browser how the text is to be used, not 
how it is displayed.    The browser will determine how it will display each of the logical styles.    
Things such as abbreviations, acronyms, computer code, author names, variables, deleted text, 
and footnotes are examples of logical styles.    It is a consistent way to define what your text 
really is.    If you surround a sample of computer code with the <CODE></CODE> tags, 
depending on the browser, it may display the text as an equal spaced font (such as Courier), but
it will always be considered to be computer code by the browser, and the user will recognize it 
as code by looking at it on-screen.    Another example is deleted text.    If a legal document is on 
the Web and the author wants a certain selection of it to be known as deleted text, then he/she 
could surround that text with the <DEL></DEL> tags and the browser may choose to show it like
this:

Deleted text

The important thing is that the text is not only struck through, but it has been defined as deleted 
text so the user knows the reason why it has been struck through.

Paragraph and Text Elements
There are several paragraph elements that can add to your Web page for a cleaner format.    
One of the main elements is the horizontal rule.    This is simply a line which spans from the left 
side of the screen to the right.    It serves the purpose of separating one thing from another on 
the page.    It looks great under the title of your Web page by separating the main text from the 
big lettered heading, as shown below:

Dogs and Cats



------------------------------------------------------------------------------------------------------------------

Dogs and cats don't always get along, but there are examples of them being very friendly to 
each other, and often being best friends.

The tag for a horizontal rule is simply <HR> (with no closing tag).    It isn't associated with any 
text.    In other words, it stands alone.    Horizontal rules prevent the user's eyes from getting lost 
in all the text.

Another important paragraph tag is in fact the Paragraph tag <P></P>.    The current HTML 2.0 
specification requires only the opening tag <P>, but HTML 3.0 will include both opening and 
closing tags because alignment attributes will be included with this tag.    These will allow you to 
align/justify specified paragraphs to the right, center or left.    The paragraph tags <P></P> 
define the beginning and end of a paragraph.    When the browser sees the <P> tag it starts the 
following text on a new line.    The following code shows this:

This is the last sentence in paragraph 1.<P>This is the first sentence in paragraph 2.</P>

will look like this:

This is the last sentence in paragraph 1.

This is the first sentence in paragraph 2.

Another important paragraph element is the Line Break <BR>.    The line break has only the 
opening tag and it isn't associated with any text much like the horizontal rule tag <HR>.    The 
line break will break a line of text wherever the <BR> tag was positioned.    The text following the
<BR> tag will be forced onto the next line.    For example:

I want this sentence to be broken in the<BR>middle so it won't go all the way to the right 
margin.

I want this sentence to be broken in the 
middle so it won't go all the way to the right margin.

There are many other paragraph tags available.

Hypertext
A web page with a bunch of text on it isn't that exciting to look at.    Suppose you had ten 
chapters of a book on one Web page.    Who would scroll down that one Web page to find 
chapter 10??    It could take a long time to find it, and people on the Internet don't have time to 
look for things (especially when they frustrate them).    This is where hypertext comes into play.   
Hypertext is regular text that is highlighted in a different color to tell the user that it can be 
clicked on with the mouse cursor.    Where it takes you nobody knows!    A 'hyperlink' can take 
you to another Web page, Web site, a picture, sound, or movie clip.    This is the dynamic part of



the Web.    No one would be as excited if there weren't hyperlinks linking us to a billion different 
things on one page.    
So how does hypertext help us with the 10 chapters of the book?    Well, you can set up a table 
of contents and have every chapter title be hypertext.    If the user wants to go directly to chapter
10 without looking for it, he/she can just click on 'Chapter 10' in the table of contents and 
chapter 10 will pop up on their screen.    
Hypertext also helps when you're putting together a personal page for yourself and you have 
links to all of your favorite Web sites.    You don't have to remember what the names of the Web 
sites are, you just have to click on them.    By the way, Web page addresses like 
http://www.website.com/ are called Uniform Resource Locators (URLs).    Below is the format of 
a hypertext link:

<A HREF="http://www.website.com/index.html"> your hypertext here </A>

Let's start at the beginning of this tag.    The 'A' stands for anchor since this tag is really an 
anchor tag.    HREF='' contains the URL, anchor name or file name that the hypertext is linked 
to.    The phrase 'your hypertext here' is the location where you type the text which you wish to 
be highlighted so users can click on it to be linked to the new location.    The only thing that the 
user will see on the screen is the hypertext.    The other code within the < > brackets is not seen.
The line of code is then closed with the </A> tag.    Let's look at an example.    If you wanted the 
words 'Web Weaver' to be hypertext in your document, and you wanted the user to be linked to 
the web Weaver home page when they clicked on the words 'Web Weaver' then you would input
this code:

My favorite HTML editor is <A HREF="http://www.tiac.net/users/mmm/ww5a.html">Web 
Weaver</A> because it's really easy to use!

This would appear like this to the user:

My favorite HTML editor is Web Weaver because it's really easy to use!

and they could click on 'Web Weaver' and be sent to the Web Weaver home page.

It's that easy!

Inline Images
Without pictures and graphics, Web pages would be pretty boring.    That's why it's important to 
have just the right amount of graphics in your Web page.    Having too many graphics will make 
your Web page large in size, and it will take much longer to download.    People who are 
browsing your page may become frustrated waiting for it to download and leave your page 
before it has even finished downloading.    It's important to include just the right amount of 
images in your HTML document.
The main graphic formats that are acceptable to Web pages and browsers are bitmap(BMP), 
Joint Photographic Experts Group(JPEG), and GIF formats.    GIF images are widely used and 
are the most common.    JPEG images are advantageous to use because they can compress to 
a fraction of the size of a GIF image without losing too much quality.    This is important because 
if you can have your images be a tenth of the size they currently are, then users can download 



your page about ten times as fast.    
Inserting inline images into your HTML document is quite easy.    There are many attributes 
('extras') that can be included in the HTML code which alter the layout of the image, but they are
not necessary for simply plopping a picture onto your page.    The code is as follows:

<IMG SRC="picture.gif">

Let's dissect this code as we have done before.    Of course, we begin with the less than bracket
to tell the browser that the following text is HTML code to    interpret.    The IMG tag tells the 
browser that an IMAGE is being inserted into the document at this point.    The browser needs to
know the name of the image in order to show it, so the SRC tag specifies the SOURCE of the 
image (the image filename).    The image filename happens to be 'picture.gif' located in between
the quotation marks.    The inline image tag is then closed with the greater than bracket.
If you wish to see how the image attributes work, just consult the help file and they are defined 
there.

Linked inline images are much like hypertext.    They are shown on the screen as the specified 
image with a blue border around it.    The mouse cursor also changes into a hand when it is 
dragged across it.    The HTML code for a linked inline image is just a combination of the image 
tag and the anchor tag discussed above.    Below is the example code for a linked inline image.

<A HREF="http://www.website.com/index.html"><IMG SRC="picture.gif"></A>

The linked inline image tag begins with the anchor tag, and the site that the image links to is 
specified by the HREF tag.    The linked site is in quotes 'http://www.website.com/index.html'.    
The greater than bracket then closes that tag, and this tells the browser that the next item or text
is the highlighted linked item or hypertext.    In this case, the linked item is the image 'picture.gif'. 
Lastly, the closing anchor tag </A> finishes up the code, and informs the browser that anything 
coming after the closing anchor tag is not to be linked.

Well, you've graduated!!    Hopefully this gave you a good idea of what HTML is and how to use 
it.    HTML is not a hard language to learn, and it can be a lot of fun.    All it takes is a little 
practice.



Bug Fixes/Improvements in Web Weaver

Bug Fixes/Improvements since Web Weaver 5.0a:
- The toolbox has been fixed!!!    It no longer hides behind the main Web Weaver 
window.

- Find/Replace has been fixed.    It behaves more like it should.    It now counts the 
number of replacements that you make if you 'replace all'.

Bug Fixes/Improvements since Web Weaver 5.0:
- OK, OK.    Here's the FINAL story on <P>, <HR>, and <BR>.    I used to put carriage
returns in front of or behind these tags because I thought it would be easier to input
them until
I started getting frustrated.    From now on, when you enter a <P>, <HR>, or <BR> 
tag it 
will be inserted EXACTLY at the position of your cursor, and your cursor will end up
on the right side of that code.    The exception is <P> which has changed to 
<P></P> in HTML 3.0.    The cursor will end up between the tags if no text was 
selected before inserting 
the <P> tag OR the cursor will end up to the right of the end tag </P>.    The main 
thing
is that you won't have to guess where to put your cursor to get these tags into the 
correct positions.

- I fixed the Align attribute in the Inline Image dialog box.    It wasn't inserting the 
Align 
attribute into the document.    That's all better now.

-The toolbox no longer disappears behind the Web Weaver screen, and when you 
close the toolbox and re-open it the toolbox items will still be there.    Also, 
minimizing Web Weaver now minimizes the toolbox, and maximizing it will restore 
the toolbox.

- The Form Maker now has the Select and TextArea input types included.    Also, Form
Maker now includes a Input Type preview so you can see what each type of Input 
Type will look like.

- The browsing for image filenames was changed so that only the filename (not the 
path) is inserted into the text box.    Also, there is a choice of having the lowercase 
letters changed to all uppercase with the click of a button.

- Visited link and Active link text colors were added to the Background/BGColor 
dialog box.    Also, in version 5.0 when a user clicked CANCEL in the color selection 
dialog box the HEX code would be placed in the BGColor text box anyway.    This is 
now fixed.    Also, only a maximum of six characters can be typed into these BGColor



boxes.    This reduces the error if you happen to type more than 6 by accident.

- The Cut and Copy buttons were switched so that they matched industry standard 
conventions (like Microsoft Word).

- In the hypertext input box, you can now press <ENTER> when typing in the Link 
box and the HTML code will be placed in the document.    Before you had to type in 
the Link box and then click OK.

- The Align radio buttons have been switched to a List Box to minimize space.

-    The Save As dialog box used to read 'Insert File' after you inserted a file.    This 
has been fixed.

- When maximizing a document in version 5.0, the Web Weaver title bar would read:
'Web Weaver 5.0 - [Untitled:1] - Filename.htm'.    This has been fixed so the 
'Untitled:1' is no longer there.

- The shortcut key for Enlarge Font has been switched to CTRL-N.    Now the Center 
tag has the CTRL-E shortcut key.

- In version 5.0, when exiting Web Weaver, the Windows task list reported Web 
Weaver as still running.    This has been fixed.

Bug Fixes/Improvements since Web Weaver 4.0b:
These fixes improve the functionality of Web Weaver and make it more similar to 
conventional editors/word processors.

- Along with the multiple document editing comes a File menu more similar to 
conventional software.    Save As, Save, Close, and Exit all work in the conventional 
way.    When you have edited a file and choose Exit, Web Weaver asks if you wish to 
save the file instead of asking "Are you sure you wish to quit?"

- Print is still being worked on even though it works.    

- Removed the horizontal scrollbar from the text windows so a hard return will not 
have to be hit in order for you to get to the next line.    Otherwise you could keep 
typing and the line of text would keep running off the page.

- Switched the positions of the Cut and Copy buttons to mimic the configuration of 
Microsoft Word.

- When pressing the <P> button or menu item the insertion of the "<P>" is 
preceded by a carriage return.    Before, a carriage return came after the "<P>" was 
inserted.    It is common HTML practice to type "<P>" at the beginning of a new line 



and then directly following it with the text of the new paragraph.    The change of 
this button/menu item makes this more intuitive.

- The <HR> insert tag was also changed so that a carriage return precedes AND 
comes after the "<HR>".    This makes it easy to press the <HR> button when at the
end of a sentence, and the cursor will feed to the next line, insert "<HR>" and then 
feed to the following line.

- Selected text in the editor window is automatically placed in the Anchor box when 
the Anchor menu item is chosen.    

- Graphics menu item is now called Inline Image.

- The Align feature in the Inline Images box is fixed so that double-clicking in the 
background of the box clears ALL values.    Also, previously both Netscape and 
normal HTML Align values could simultaneously be chosen when there should 
actually only be one choice for insertion.    This is fixed so that the Align values can 
only have one selected choice.

- Netscape Item types in the Numbered List box is fixed so that double-clicking 
won't cause errors during insertion.    The clearing of the values used to accidentally 
clear the Start value which would cause an error if you tried to insert. 

- The Address tag was placed in the Paragraph/Text Elements and MailTo Tag was 
added to the Netscape Extensions menu item.

- Browse buttons added to the Inline Images box and Hypertext box.

- The ability to type in the desired input in dialog boxes like Hypertext, Inline Image, 
Anchors, Lists and hit the <ENTER> key to say "OK" instead of having to type then 
click on OK to submit the input.



What is Web Weaver?

Web Weaver is a comprehensive, feature-rich HTML text editor for Windows which 
makes it easy to create Web pages.    Web Weaver is a powerful editor which is ideal 
for beginners as well as advanced users of HTML.

Here are some features of Web Weaver:

Frames, Tables and Forms are all supported by Web Weaver.    It includes easy to 
use wizards for creating these advanced HTML elements.

HTML 2 and 3.2 tags are supported by Web Weaver.

Easy-to-use toolbars which automate repetitive keyboard input (such as <P>, 
<BR>)

Intuitive dialog boxes for the insertion of hypertext, inline images, anchors, lists, 
etc.

Context-sensitive help with a great HTML reference covering HTML 2 and 3 
specifications.

Netscape and Internet Explorer HTML Extensions are included.

Links to a specified browser at the push of a button.    This allows the user to 
view their document.

Strip HTML tags from a document by pushing the strip button.    This results in 
the creation of a text document with HTML tags removed.

Easily convert existing lists and delimited text(from Excel spreadsheets, etc.) to 
HTML files.



Helpful Web Sites

Below is a list of helpful Web sites which provide manuals on HTML authoring, 
advanced authoring, and sites which provide extras such as backgrounds, 
horizontal rules, etc.

Introduction to HTML Documentation:
http://www.utirc.utoronto.ca/HTMLdocs/NewHTML/intro.html

Information on creating Web Sites:
http://home.mcom.com/assist/net_sites/index.html

Information on creating High Impact Documents:
http://home.mcom.com/assist/net_sites/impact_docs/index.html

HTML Quick Reference Guide:
http://www.ucc.ie/~pflynn/books/htmlcard.html

The WWW Consortium (straight from the horse's mouth):
http://www.w3.org/

Netscape Tables:
http://home.mcom.com/assist/net_sites/tables.html

Fill-Out Forms in HTML:
http://utirc.utoronto.ca/HTMLdocs/NewHTML/forms.html

Common Gateway Interface: Forms:
http://hoohoo.ncsa.uiuc.edu/docs/cgi/forms.html

Guide to Fill-Out Forms:
http://www.ncsa.uiuc.edu/SDG/Software/Mosaic/Docs/fill-out-forms/overview.html



Other Products by McWeb Software

Java Perk is McWeb Software's latest release!    It easily creates Java animations to 
enhance your Web pages and make them into eye-catching masterpieces!    Java Perk acts 
as a front end for setting parameters for existing Java applets. 

Just pick which images you want in the animation, which sounds you wish to be played, how 
fast you wish the animation to be, etc and Java Perk creates the HTML code for your 
animation automatically!!

Java Perk also helps you create slideshows and billboards with your images as well as 
dynamic buttons which change when the user moves their mouse cursor over the 
button and when the user clicks on the button. 

Another applet is included which types specified text one letter at a time (like on a typewriter).

Many other Java applets are to come!

For more info go to 

http://www.mcwebsoftware.com/javaperk.html



Shortcut Keys

Below is a list of shortcut keystrokes you can use to make programming HTML much
easier in Web Weaver:

F1 Context Sensitive Help

Shift-F1 Heading 1
Shift-F2 Heading 2
Shift-F3 Heading 3
Shift-F4 Heading 4
Shift-F5 Heading 5
Shift-F6 Heading 6

F3 Find Again
F5 Opens Browser
F6 HTML Stripper
F7 Image Mapping Software
F8 FTP Client

Cntrl-B Bold
Cntrl-I Italic
Cntrl-U Underline

Cntrl-F1 Subscript
Shift-Cntrl-F1 Superscript
Cntrl-E Center tag
Cntrl-K Line Break tag
Cntrl-L List item tag
Cntrl-H Horizontal Rule
Cntrl-P Paragraph
Cntrl-N Enlarge screen font size
Cntrl-R Reduce screen font size

Cntrl-T Inserts <TABLE></TABLE> tag
Cntrl-R Inserts <TR></TR> tag
Cntrl-D Inserts <TD></TD> tag

Cntrl-C Copy
Cntrl-X Cut
Cntrl-V Paste
Cntrl-D Delete



Troubleshooting

Below are some problems that you might run into...

Why doesn't Web Weaver print documents?
There have been problems with the code when trying to program Web Weaver to 

print.    As a quick fix, I've allowed the user to assign another editor such as 
Windows Notepad, Write or WordPad to print the HTML documents.    At some 
point in the future printing is expected to be fixed, but it is not a priority.    I 
invest time in programming other features into Web Weaver to make it a more 
powerful HTML editor.    Printing can be performed from any other generic editor.

Why doesn't Link to Browser work?
Make sure the Browser path and filename is specified correctly in the INI file, and 

that the INI file is in the same directory as the Web Weaver program.    In 
Windows 95, Web Weaver may not recognize the path/filename of your browser 
if the path consists of a large number of characters.    Try to keep the paths short 
in length.

Why does Web Weaver open a new Netscape window each time I press 
Link to Browser?

This is a limitation of Web Weaver and most other HTML editors.    You'll have to Alt-
Tab to Netscape and reload or load the current HTML document.

Why can't Web Weaver find my WEBWEV.INI file??
The WEBWEV.INI file could be in a different directory than the Web Weaver program 

file.    In order for the program to find the INI file, they must be in the same 
directory AND they cannot be in the root directory together.

Why aren't the toolbox button settings I specified in the INI file being 
loaded into the toolbox??

Well, you must be doing something wrong.    That's the only explanation I can think 
of.    How's that for technical support??    

Just kidding!    If you mimicked the example INI file that I included with the program 
and the INI file is in the same directory as the Web Weaver program, then 
everything should work.

Although, there might also be a problem if you ,for example, specify settings for 
button 4 and button 6, but not for button 5.    Web Weaver will most likely only 
show button 4 on the toolbox.    Try not to skip button numbers if you are 
specifying less than 5 buttons.

You can set the buttons automatically by choosing Options/Toolbox settings from the
main pull-down menu.



If you have any questions feel free to email McWeb Software at 
info@mcwebsoftware.com



Toolbox

This opens or closes the toolbox window which has buttons available for user 
defined HTML macros to make HTML tag insertion a little more user friendly.

The user can specify the tags for 5 of the buttons on the toolbox.    This is done by 
changing them using the Options/Toolbox settings dialog box or by editing the 
webwev.ini file.    Using the Toolbox settings dialog box is much easier.    Just choose 
Options, then Toolbox settings from the menu bar.

To change the button designations manually:
The user-defined line in the webwev.ini file reads as follows:

Button4=Paragraph,<P>

where Button4 is the name of the specific button from 4 to 8, "Paragraph" is the text
that is shown on the button, and "<P>" is the tag that is inserted into the 
document.



Functions Menu

Listed below are the functions found in the Functions pull-down menu.

LINK TO BROWSER    -    Shortcut Key:    F5
Pressing the Link to Browser button (or choosing its menu item) will result in the 
specified browser displaying the active HTML document for WYSIWYG viewing 
purposes.    The browser path and title MUST be specified in the INI file located in the
same directory as the Web Weaver executable file.    The following format should be 
followed in the INI file:

Browser=C:\netscape\netscape.exe

This information can easily be entered using the Options/Preferences dialog box 
under the Options menu item.    Just browse for the Web browser path using the 
browse button.

The "Browser" item tells the path and executable filename of the browser.    Unlike 
previous versions of Web Weaver, the Browser Title in the INI file is no longer 
required.    In order to properly view a Web page in progress you should choose the 
Link To Browser menu item the first time in order to load the browser.    If you need 
to make changes to your Web page after viewing it, you should make the changes, 
save the document, and then Alt-Tab to switch to the already open browser and 
reload the document into the browser.    If you hit the Link To Browser menu item 
instead, it will open up a second instance of your browser and you will have two 
browsers open, and so on.

HTML STRIPPER    -    Shortcut Key:    F6
This item will parse the current HTML document, remove all HTML tags, and save 
the remaining text in a file of your choice.    A dialog box will pop-up asking you to 
specify a filename for the stripped file.    References to images will be replaced with 
"[IMAGE]", <P> will be replaced with a carriage return, <HR> will be replaced with a
dashed line, and some special characters (quotation marks, for example) tags will 
be replaced with the actual character.

OPEN IMAGE MAPPER    -    Shortcut Key:    F7
This item will open the image mapping program(Map THIS!) that is included with 
Web Weaver (assuming you've specified the correct path and filename in your INI 
file using the Options/Preferences dialog box).

OPEN FTP CLIENT    -    Shortcut Key:    F8
This item will open the FTP Client program of your choice (assuming you've 
specified the correct path and filename in your INI file using the Options/Preferences
dialog box).




